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List of Abbreviations

ALARA as low as reasonably achievable
AMCSD American Mineralogist Crystal Structure Database
BAG Bundesamt für Gesundheit (Schweiz)
CCD charge-coupled device
DHCP dynamic host configuration protocol
EFUP environment-friendly use period
FWHM full width at half maximum
HVPS high-voltage power supply
LAN local area network
OSS open source software
PXRD powder X-ray diffraction
RIR reference intensity ratio
RöV Röntgenverordnung (Deutschland)
StrSchG Strahlenschutzgesetz (Österreich)
SUVA Schweizerische Unfallversicherungsanstalt
WLAN wireless local area network
XRD  X-ray diffraction
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Labels and Symbols

Safety-related labels and symbols are attached to the BTX III X-ray diffraction 
analyzer (see Figure i-1 on page 2). If any of the labels or symbols are missing or 
illegible, please contact Olympus.
Labels and Symbols 1
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Figure i-1  X-ray warning labels

The radiation symbol may differ according to your location (see “Safety Symbols” on 
page 7). 

NOTE
Labels and Symbols2
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The rating label is attached to the BTX III analyzer. The label symbols are described in 
Table 1 on page 3.

Table 1  Content of the rating label 

Item Description

This device complies with Part 15 of the FCC Rules. 
Operation is subject to the following two conditions: (1) this 
device may not cause harmful interference, and (2) this 
device must accept any interference received, including 
interference that may cause undesired operation.

The CE marking is a declaration that this product conforms 
to all the applicable directives of the European Community. 
See the Declaration of Conformity for details. Contact your 
Olympus representative for more information.

The WEEE symbol indicates that the product must not be 
disposed of as unsorted municipal waste, but should be 
collected separately.

The regulatory compliance mark (RCM) label indicates that 
the product complies with all applicable standards, and has 
been registered with the Australian Communications and 
Media Authority (ACMA) for placement on the Australian 
market.
Labels and Symbols 3



10-015490-01EN, Rev. 3, June 2021
The KCC marking is a declaration that this product conforms 
to all the applicable standards of South Korea. Contact your 
Olympus representative for more information. The MSIP 
code for the BTX III is the following: R-R-OYN-BTXIII.

The China RoHS mark indicates the product’s Environment-
Friendly Use Period (EFUP). The EFUP is defined as the 
number of years for which listed controlled substances will 
not leak or chemically deteriorate while in the product. The 
EFUP for the BTX III has been determined to be 15 years. 
Note: The Environment-Friendly Use Period (EFUP) is not 
meant to be interpreted as the period assuring functionality 
and product performance.

The direct current symbol.

SERIAL NUMBER The serial number is in the following format: BTX-XXX
where: XXX represents a three-digit number

Table 1  Content of the rating label (continued)
Labels and Symbols4
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Important Information — Please Read Before Use

Intended Use

The BTX III X-ray diffraction analyzer is designed primarily for analyzing a variety of 
powder sample types.

Do not use the BTX III analyzer for any purpose other than its intended use. It must 
never be used to inspect or examine human or animal body parts.

Instruction Manual

This instruction manual contains essential information on how to use this Olympus 
product safely and effectively. Before using this product, thoroughly review this 
instruction manual. Use the product as instructed.

Keep this instruction manual in a safe, accessible location.

WARNING
Important Information — Please Read Before Use 5
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Some of the details of components and/or software images in this manual may differ 
from your instrument’s components or software display. However, the principles 
remain the same. 

Instrument Compatibility

The BTX III XRD analyzer is primarily a self-contained unit. However, it does have a 
series of I/O ports that can be used to connect compatible peripherals and connect it to 
a PC. The unit derives its required DC input power from the BTX III analyzer’s AC 
adaptor.

Always use equipment and accessories that meet Olympus specifications. Using 
incompatible equipment could cause equipment malfunction and/or damage, or 
human injury.

Repair and Modification

The BTX III XRD analyzer does not contain any user-serviceable parts, apart from one 
exception: the measurement window. If the measurement window is damaged, the 
window assembly should be replaced as soon as possible. This User’s Manual 
contains more details on this procedure. 

In order to prevent human injury and/or equipment damage, do not disassemble, 
modify, or attempt to repair the instrument.

IMPORTANT

CAUTION

CAUTION
Important Information — Please Read Before Use6
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Safety Symbols

The following safety symbols might appear on the instrument and in the instruction 
manual:

 General warning symbol
This symbol is used to alert the user to potential hazards. All safety messages that 
follow this symbol shall be obeyed to avoid possible harm or material damage.

 Radiation warning symbol (International)

 Radiation warning symbol (Canada)

 Radiation warning symbol (China)
These symbols are used to alert the user to the presence of potentially harmful 
ionizing radiation generated within the XRD analyzer. All safety messages that 
follow this symbol shall be obeyed to avoid possible harm.

 Shock hazard caution symbol
This symbol is used to alert the user to potential electric shock hazards. All safety 
messages that follow this symbol shall be obeyed to avoid possible harm.

Safety Signal Words

The following safety signal words might appear in the documentation of the 
instrument:

The DANGER signal word indicates an imminently hazardous situation. It calls 
attention to a procedure, practice, or the like that if not correctly performed or 
adhered to will result in death or serious personal injury. Do not proceed beyond a 
DANGER signal word until the indicated conditions are fully understood and met.

DANGER
Important Information — Please Read Before Use 7
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The WARNING signal word indicates a potentially hazardous situation. It calls 
attention to a procedure, practice, or the like that if not correctly performed or 
adhered to could result in death or serious personal injury. Do not proceed beyond a 
WARNING signal word until the indicated conditions are fully understood and met.

The CAUTION signal word indicates a potentially hazardous situation. It calls 
attention to a procedure, practice, or the like that if not correctly performed or 
adhered to may result in minor or moderate personal injury, material damage, 
particularly to the product, destruction of part or all of the product, or loss of data. Do 
not proceed beyond a CAUTION signal word until the indicated conditions are fully 
understood and met.

Note Signal Words

The following note signal words could appear in the documentation of the 
instrument:

The IMPORTANT signal word calls attention to a note that provides information that 
is important or essential to the completion of a task.

The NOTE signal word calls attention to an operating procedure, practice, or the like, 
that requires special attention. A note also denotes related parenthetical information 
that is useful, but not imperative.

The TIP signal word calls attention to a type of note that helps you apply the 
techniques and procedures described in the manual to your specific needs, or that 
provides hints on how to effectively use the capabilities of the product.

WARNING

CAUTION

IMPORTANT

NOTE

TIP
Important Information — Please Read Before Use8
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Safety

Before turning on the instrument, verify that the correct safety precautions have been 
taken (see the following warnings). In addition, note the external markings on the 
instrument, which are described under “Safety Symbols” on page 7.

Warnings

General Warnings

• Carefully read the instructions contained in this instruction manual prior to 
turning on the instrument.

• Keep this instruction manual in a safe place for further reference.
• Follow the installation and operation procedures.
• It is imperative to respect the safety warnings on the instrument and in this 

instruction manual.
• If the equipment is used in a manner not specified by the manufacturer, the 

protection provided by the equipment could be impaired.
• Do not install substitute parts or perform any unauthorized modification to the 

instrument.
• Service instructions, when applicable, are for trained service personnel. To avoid 

the risk of electric shock, do not perform any work on the instrument unless 
qualified to do so. For any problem or question regarding this instrument, contact 
Olympus or an authorized Olympus representative.

• Do not touch the connectors directly by hand. Otherwise, a malfunction or electric 
shock may result.

• Do not allow metallic or foreign objects to enter the device through connectors or 
any other openings. Otherwise, a malfunction or electric shock may result.

• Make sure no BTX III components (screws, straps, etc.) have come loose or are lost 
in critical equipment being inspected. Thoroughly check your inspection area 
before and after an inspection to prevent foreign-object debris (FOD) that could 
potentially cause equipment damage, injuries, or loss of life. 

WARNING
Important Information — Please Read Before Use 9



10-015490-01EN, Rev. 3, June 2021
   Radiation Safety Warning

Do not open the system, disassemble, or modify any internal components. These 
actions could result in serious damage to the system and a health hazard to the 
operator.

Electrical Warnings 

• Before operating this instrument using mains electricity, you must connect the 
protective earth terminal of the instrument to the protective conductor (mains) of 
the power cord. The mains plug shall only be inserted into a socket outlet 
provided with a protective earth contact. Never negate the protective action by 
using an extension cord (power cable) without a protective conductor 
(grounding).

• Only use fuses with the required rated current, voltage, and specified type 
(normal-blow, slow-blow, quick-acting, etc.). Do not use repaired fuses or short-
circuited fuse holders, doing so could cause electric shock or create a fire hazard. 

• If there is any possibility that the ground protection could be impaired, you must 
make the instrument inoperative and secure it against any unintended operation. 

• The instrument must only be connected to a power source corresponding to the 
type indicated on the rating label.

If an unauthorized power supply cord is used to power the instrument, Olympus 
cannot guarantee the electrical safety of the equipment. 

WARNING

CAUTION
Important Information — Please Read Before Use10
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High Voltage

The BTX III XRD analyzer uses a 30 kV high-voltage power supply (HVPS) for X-ray 
generation. The permanent connection between the HVPS and the X-ray tube is sealed 
and shielded in such a way that no high voltage connector could accidentally get loose 
or disconnected inside the system. There is no high voltage risk to the user when 
using the BTX III analyzer under normal conditions. Should you notice substantial 
damage to the outside of the system, or suspect any internal damage after excessive 
shock, DO NOT turn on the system, return it to the factory for full inspection and 
potential repairs.

• X-ray tubes and detectors in this instrument contain beryllium metal in the form 
of coated foil. In its as-supplied state, the beryllium poses no harm to the user. 
However, if a detector or tube is damaged, contact with small particles is possible 
if the instrument is breached (for example, a window is broken or during window 
replacement). Intact skin is sufficient protection against this situation and 
washing with soap and water will effectively remove any beryllium 
contamination. If granulated beryllium embeds in an open wound, seek medical 
attention. 

• Instruments with a damaged detector or tube must be returned to your local 
distributor or the manufacturer. Care should be taken to limit the release of 
beryllium from the instrument. 

Warning Labels

Warning labels and pictograms could appear on the inspection system to alert 
operators about hazardous areas. Keep clear of such areas to avoid injury.

WARNING

CAUTION
Important Information — Please Read Before Use 11



10-015490-01EN, Rev. 3, June 2021
Richtlinien für den Strahlenschutz im deutschsprachigen Raum

Deutschland

Der Betrieb eines tragbaren Röntgenfluoreszenzanalysators ist in jedem Fall genehmi-
gungspflichtig (§ 3 RöV).

Sorgen Sie dafür, dass in Ihrem Betrieb mindestens ein Strahlenschutzbeauftragter 
mit Fachkunde R2 nach der deutschen Röntgenverordnung verfügbar ist. Darüber hi-
naus sollten Sie die Bediener regelmäßig schulen lassen. Eine jährliche Unterweisung 
der Bediener ist vom Strahlenschutzbeauftragten durchzuführen.

Es ist i. d. R. ein Betriebsbuch (Nachweis der Betriebszeiten, Wartungsarbeiten und 
Störfälle) zu führen. Eine betriebliche Strahlenschutzanweisung ist zu erstellen und 
mit der deutschsprachigen Bedienungsanleitung den Gerätebedienern jederzeit zu-
gänglich zu machen.

Das Strahlenschutztechnische Gutachten für das jeweilige Instrument wird bei Aus-
lieferung des Gerätes von einem behördlich zugelassenen Sachverständigen erstellt 
und sollte jederzeit einsehbar sein. Spätestens nach 5 Jahren muss dieses Gutachten 
erneuert werden.

Die Genehmigungsbehörde kann weitere Maßnahmen zur Arbeitssicherheit festle-
gen.

Österreich

Der Betrieb eines tragbaren Röntgenfluoreszenzanalysators ist genehmigungspflich-
tig.

Es ist ein Strahlenschutzbeauftragter und die entsprechende Anzahl von weiteren, 
mit der Wahrnehmung des Strahlenschutzes betrauten Personen, zu nominieren. Der 
Strahlenschutzbeauftragte ist der Behörde bekannt zu geben. Der Strahlenschutzbe-
auftragte und die weiteren Personen haben eine entsprechende Ausbildung gemäß 
der allgemeinen österreichischen Strahlenschutzverordnung nachzuweisen.

Das Bedienpersonal (sofern nicht selber strahlenschutzbeauftragt) ist gemäß § 16 All-
gemeine Strahlenschutzverordnung mindestens einmal jährlich vom Strahlenschutz-
beauftragten gemäß § 29 StrSchG zu unterweisen. Dies muss dokumentiert werden.

Eine deutschsprachige Bedienungsanleitung sowie Handlungs- und Arbeitsanwei-
sungen sind dem Bedienpersonal jederzeit zur Verfügung zu stellen.
Important Information — Please Read Before Use12
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Es wird empfohlen jeden Bediener mit einem amtlichen Dosimeter auszurüsten.

Schweiz

Der Betrieb von Röntgenfluoreszenzanalysatoren ist der BAG anzuzeigen (Bewilli-
gungsverfahren).

Für den Einsatz von tragbaren Röntgengeräten ist für jeden Betrieb ein für den Strah-
lenschutz verantwortlicher Mitarbeiter zu benennen, der eine dem Schweizer Strah-
lenschutzgesetz genügende Ausbildung bei der SUVA (eintägiger Kursus) erfolgreich 
absolviert hat.

Die Bedienungsanleitung sowie weitere eventuell von den Behörden geforderte Un-
terlagen wie Arbeitsanweisungen und Anweisung im Falle von Störungen müssen 
den Bedienern zugänglich gemacht werden.

Tragbare RFA-Geräte mit offenem Strahlengang müssen im Zwei-Hand-Modus be-
dient werden.

Equipment Disposal

Before disposing of the BTX III, check your local laws, rules, and regulations, and 
follow them accordingly.

CE (European Community)

This device complies with the requirements of directive 2014/30/EU 
concerning electromagnetic compatibility, directive 2014/35/EU 
concerning low voltage, and directive 2015/863 which amends 
2011/65/EU concerning restriction of hazardous substances (RoHS). 
The CE marking indicates compliance with the above directives.
Important Information — Please Read Before Use 13
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UKCA (United Kingdom)

WEEE Directive

China RoHS

China RoHS is the term used by industry generally to describe legislation 
implemented by the Ministry of Information Industry (MII) in the People’s Republic 
of China for the control of pollution by electronic information products (EIP).

“ 中国 RoHS” 是一个工业术语，一般用于描述中华人民共和国信息工业部 （MII）针

对控制电子信息产品 （EIP）的污染所实行的法令。

This device complies with the requirements of the Electromagnetic 
Compatibility Regulations 2016, the Electrical Equipment (Safety) 
Regulations 2016, and the Restriction of the Use of Certain Hazardous 
Substances in Electrical and Electronic Equipment Regulations 2012. 
The UKCA marking indicates compliance with the above regulations.

In accordance with European Directive 2012/19/EU on Waste Electrical 
and Electronic Equipment (WEEE), this symbol indicates that the 
product must not be disposed of as unsorted municipal waste, but 
should be collected separately. Refer to your local Olympus distributor 
for return and/or collection systems available in your country.

The China RoHS mark indicates the product’s Environment-
Friendly Use Period (EFUP). The EFUP is defined as the number of 
years for which listed controlled substances will not leak or 
chemically deteriorate while in the product. The EFUP for the 
BTX III has been determined to be 15 years. 
Note: The Environment-Friendly Use Period (EFUP) is not meant 
to be interpreted as the period assuring functionality and product 
performance.
Important Information — Please Read Before Use14
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Korea Communications Commission (KCC)

KC (South Korea Community)

This device complies with the requirements of KN 61000-6-2 and KN 61000-6-4 
concerning electromagnetic compatibility. The KC marking indicates compliance with 
the above standards.

电气电子产品
有害物质

限制使用标识

中国 RoHS 标识是根据 “ 电器电子产品有害物质限制使用管理办

法 ” 以及 “ 电子电气产品有害物质限制使用标识要求 ” 的规定，适

用于在中国销售的电气电子产品上的电气电子产品有害物质限制使
用标识。

注意：电气电子产品有害物质限制使用标识内的数字为在正常的使
用条件下有害物质不会泄漏的年限，不是保证产品功能性的年限。

产品中有害物质的名称及含量

有害物质

部件名称 铅及其
化合物

汞及其
化合物

镉及其
化合物

六价铬及
其化合物

多溴联苯 多溴
二苯醚

(Pb) (Hg) (Cd) (Cr( Ⅵ )) (PBB) (PBDE)

机构部件 × ○ ○ ○ ○ ○
主体 光学部件 × ○ ○ ○ ○ ○

电气部件 × ○ ○ ○ ○ ○
附件 × ○ ○ ○ ○ ○

本表格依据 SJ/T 11364 的规定编制。

○：表示该有害物质在该部件所有均质材料中的含量均在 GB/T26572 规定的限量要求以下。

×：表示该有害物质至少在该部件的某一均质材料中的含量超出 GB/T26572 规定的限量要求。

이 기기는 업무용 환경에서 사용할 목적으로 적합성평가를 받은 기기로서 
가정용 환경에서 사용하는 경우 전파간섭의 우려가 있습니다 .
Important Information — Please Read Before Use 15



10-015490-01EN, Rev. 3, June 2021
EMC Directive Compliance

This equipment generates and uses radio-frequency energy and, if not installed and 
used properly (that is, in strict accordance with the manufacturer’s instructions), may 
cause interference. The BTX III has been tested and found to comply with the limits 
for an industrial device in accordance with the specifications of the EMC directive 
2014/30/EU.

FCC (USA) Compliance

This product has been tested and found to comply with the limits for a Class A digital 
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference when the product is operated in a 
commercial environment. This product generates, uses, and can radiate radio 
frequency energy, and if not installed and used in accordance with the instruction 
manual, might cause harmful interference to radio communications. Operation of this 
product in a residential area is likely to cause harmful interference, in which case you 
will be required to correct the interference at your own expense.

Changes or modifications not expressly approved by the party responsible for 
compliance could void the user’s authority to operate the product.

FCC Supplier’s Declaration of Conformity

Hereby declares that the product, 
Product name: BTX III X-ray Diffraction Analyzer
Model: BTX III

Conforms to the following specifications: 
FCC Part 15, Subpart B, Section 15.107 and Section 15.109.

NOTE

WARNING
Important Information — Please Read Before Use16
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Supplementary information:
This device complies with Part 15 of the FCC Rules. Operation is subject to the 
following two conditions:

(1) This device may not cause harmful interference.
(2) This device must accept any interference received, including interference

that may cause undesired operation.
Responsible party name: 

Olympus Scientific Solutions Americas Corp.

Address:
48 Woerd Avenue, Waltham, MA 02453, USA

Phone number:
+1 781-419-3900

ICES-001 (Canada) Compliance

This Class A digital apparatus complies with Canadian ICES-001.

Cet appareil numérique de la classe A est conforme à la norme NMB-001 du Canada.

Code de la santé publique (France)

Conformément aux articles L. 1333-4 et R. 1333-17 du Code de la santé publique, 
l’utilisation ou la détention de ces analyseurs sont des activités soumises à 
autorisation de l’Autorité de sûreté nucléaire.

Packing and Return Shipping

If the BTX III is not returned in its transport case, it could be damaged during 
shipping. Olympus reserves the right to void the warranty on instruments damaged 
while in transit if they are shipped without their transport case. Prior to returning any 
units, contact Customer Service to obtain the required RMA number(s) and any 
important shipping information.
Important Information — Please Read Before Use 17
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Follow the steps below to return your BTX III:

1. Pack the BTX III back into the transport case that it came in using the original 
packing materials.

2. Include the RMA in the case, and reference the RMA number in your shipping 
documents.

3. Close the transport case and do at least one of the following:
— Secure the case with plastic zip ties.
— Pack the transport case within another box.

Open Source Software

This product may include (i) open source software; and (ii) other software whose 
source code is intentionally published (collectively, hereinafter referred to as “OSS”).   

The OSS included in this product shall be licensed and distributed to you subject to 
the terms and conditions applied to the OSS. Please see such terms and conditions of 
the OSS at the following URL:

https://www.olympus-ims.com/btx-terra-open-source-software/

The copyright owners of the OSS are listed at the above URL.

THERE IS NO WARRANTY FOR THE OSS, TO THE EXTENT PERMITTED BY 
APPLICABLE LAW. THE OSS IS PROVIDED “AS IS” WITHOUT WARRANTY OF 
ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED 
TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND 
PERFORMANCE OF THE OSS IS WITH YOU. SHOULD THE OSS PROVE 
DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR, 
OR CORRECTION.

Some of the OSS licenses associated with this product may permit you to obtain 
source code for certain software which Olympus has an obligation to provide in 
accordance with the terms and conditions applied to the OSS. You may obtain a copy 
of this source code at the following URL. This offer is valid for a period of three (3) 
years from the date of original purchase. Olympus has no responsibility to provide 
any source code except the source code for certain software.

https://www.olympus-ims.com/btx-terra-open-source-software/
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Olympus does not respond to any inquiries related to any of the source codes 
obtained at the above URL.

Warranty Information

Olympus guarantees your Olympus product to be free from defects in materials and 
workmanship for a specific period, and in accordance with conditions specified in the 
Olympus Scientific Solutions Americas Inc. Terms and Conditions available at 
http://www.olympus-ims.com/en/terms/.

The Olympus warranty only covers equipment that has been used in a proper 
manner, as described in this instruction manual, and that has not been subjected to 
excessive abuse, attempted unauthorized repair, or modification.

Inspect materials thoroughly on receipt for evidence of external or internal damage 
that might have occurred during shipment. Immediately notify the carrier making the 
delivery of any damage, because the carrier is normally liable for damage during 
shipment. Retain packing materials, waybills, and other shipping documentation 
needed in order to file a damage claim. After notifying the carrier, contact Olympus 
for assistance with the damage claim and equipment replacement, if necessary.

This instruction manual explains the proper operation of your Olympus product. The 
information contained herein is intended solely as a teaching aid, and shall not be 
used in any particular application without independent testing and/or verification by 
the operator or the supervisor. Such independent verification of procedures becomes 
increasingly important as the criticality of the application increases. For this reason, 
Olympus makes no warranty, expressed or implied, that the techniques, examples, or 
procedures described herein are consistent with industry standards, nor that they 
meet the requirements of any particular application.

Olympus reserves the right to modify any product without incurring the 
responsibility for modifying previously manufactured products.
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Technical Support

Olympus is firmly committed to providing the highest level of customer service and 
product support. If you experience any difficulties when using our product, or if it 
fails to operate as described in the documentation, first consult the user’s manual, and 
then, if you are still in need of assistance, contact our After-Sales Service. To locate the 
nearest service center, visit the Service Centers page at: http://www.olympus-
ims.com.
Important Information — Please Read Before Use20
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Introduction

The Olympus BTX III is a benchtop X-ray diffraction (XRD) analyzer designed 
primarily for analyzing a variety of powder sample types. Phase identification is 
obtained by comparing the diffraction signature of a sample with a database of XRD 
mineral patterns.

The BTX III analyzer uses a low power X-ray source and 2-D charge-coupled device 
(CCD) detector to obtain XRD data.

The BTX III analyzer incorporates the following independent safety protection 
circuits:

• Power key switch — Key must be inserted and in the ON position to turn the 
system on.

• X-ray warning indicators — LEDs on the front panel illuminate when X-rays are 
being generated, and also during the power on sequence.

• Sample carrier safety interlock — High voltage from the power supply is 
interrupted and generation of X-rays ceases if the sample carrier is removed 
during system operation.
Introduction 21
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1. Analyzer Overview

This chapter provides an overview of the BTX III X-ray diffraction analyzer and its 
accessories.

1.1 Packing List

Table 2 on page 23 lists the BTX III components.

Table 2  BTX III components 

Component BTX III — all models
1 BTX III analyzer
Analyzer Overview 23



10-015490-01EN, Rev. 3, June 2021
2 110 V/220 V AC-DC power 
supply
#PWRS-10047/Q0201663

3 External sample shaker 
assembly

Table 2  BTX III components (continued)

Component BTX III — all models
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Accessory kit
(Plastic case Part #CASE-10033)
1 Micro spatula 

#TER11093 
2 Ball driver

#TOOL-10147 
3 Power keys (2)
4 USB flash drive (loaded 

with software, database, 
and documentation)
#TER02200

5 Sample cells (1 Kapton and 
1 Mylar)
#TER11073/#TER11074
#TER11075
#TER11076/#WIND-10008

6 Sample cell screws (8)
#TER11071

7 Sample crusher
#LBSP-10008

8 Sample sieve
#LBSP-10009 

Table 2  BTX III components (continued)

Component BTX III — all models

①

②

③
④

⑤
⑥
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1.2 Front/Top Panel

The front and top panels are where all BTX III controls, indicators, and the sample 
chamber are located (see  on page 26 and Table 3 on page 27).

Figure 1-1  BTX III front panel
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Depending on your location, the device may have a secondary indicator light on the 
top of the unit.

1.2.1 Power Key Switch

Turn the power key clockwise to turn on the BTX III analyzer (see  on page 28).

Table 3  BTX III front/top panel items 

Item Description Item Description

1 Power key switch 4 Sample chamber

2 Stop/Emergency Shutoff button 5 Keypad

3 LED indicators 6 Display

NOTE
Analyzer Overview 27



10-015490-01EN, Rev. 3, June 2021
Figure 1-2  Power key switch (On)

The power key text may display in English or French according to your location.
NOTE
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1.2.2 Keypad

The keypad enables you to make selections on the display to set up and run tests and 
save results.

Figure 1-3  Keypad

1.2.3 Stop/Emergency Shutoff Button

The Stop/Emergency Shutoff button enables you to stop an in-progress test, turn off 
system power in an emergency, or cancel a selection when using the keypad and main 
menu to set up tests (see Figure 1-4 on page 29).

Figure 1-4  Stop/Emergency Shutoff button

Depending on your location, the button may not have accompanying text.
NOTE
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1.2.4 LED Indicators

The LED indicators show the status of the high-voltage power supply, X-ray tube, and 
safety interlocks (see  on page 30).

Figure 1-5  LED indicators

Depending on your location, the device may have a secondary indicator light on the 
top of the unit.

Interlock open 
LED

High Voltage/
X-ray On LEDs

High Voltage/X-ray On LED

NOTE
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1.2.5 Sample Chamber

The sample chamber is located in the center of the top panel. The clamp lever locks 
and unlocks the sample carrier (see Figure 1-6 on page 31).

Figure 1-6  Sample chamber assembly

The Sample Chamber text may display in English or French according to your 
location.

1.2.6 Display

The display shows selections for setting up and monitoring tests (see Figure 1-7 on 
page 31).

Figure 1-7  Display

Clamp lever

Sample chamber 
(sample carrier installed)

NOTE
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The menu text may display in English or French according to your location.

1.3 Rear Panel

The rear panel is where all BTX III connectors are located (see Figure 1-8 on page 32 
and Table 4 on page 33).

Figure 1-8  BTX III rear panel

NOTE

①

③

④③②
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Table 4  BTX III rear panel connectors 

Item Description Item Description

1 External Shaker — Port for 
connecting the external sample 
shaker. The shaker is used to load 
and unload samples from the 
BTX III sample carrier.

3 Ethernet — Port for 
connecting the BTX III to an 
Ethernet network.

2 USB — Port for connecting a USB 
flash drive to transfer files to or 
from the BTX III analyzer.

4 Power — Port for 
connecting the BTX III 
analyzer to external AC 
power.
Analyzer Overview 33
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2. Safety Information

This chapter contains important safety information for using the BTX III analyzer.

2.1 Radiation Safety Information

The fundamental principle in radiation protection is that all radiation exposures 
should be maintained as low as reasonably achievable (ALARA). This is referred to as 
the ALARA principle. The three key factors which influence an individual’s radiation 
dose from a given source are time, distance, and shielding. Controlling these factors is 
the key to keeping the radiation dose ALARA.

• Time
The most direct way to reduce radiation dose is to reduce the time spent working 
with or in the vicinity of radiation sources. If the exposure time is cut in half, the 
dose will be reduced by the same fraction.

• Distance
Distance can effectively reduce a radiation dose. When the working distance from 
the radiation source is increased by a factor of two, the dose received from that 
source is reduced by a factor of four. This is referred to as the inverse square law, 
which states that the radiation intensity from a point source decreases by the 
square of the distance from the source.

• Shielding
Shielding is any material used to reduce the intensity of radiation by absorbing or 
attenuating the radiation coming from the source.
Safety Information 35



10-015490-01EN, Rev. 3, June 2021
Do not open the system, disassemble, or modify any internal components. These 
actions could result in serious damage to the system and a health hazard to the 
operator.

2.2 Safety Interlocks

The BTX III analyzer uses an X-ray tube that produces ionizing radiation at up to 
30 keV at very low power (10 W) as compared to laboratory XRD systems (typically 
greater than 1 kW). The BTX III system is designed with internal X-ray shielding to 
fully protect operators and internal components.

The radiation producing components are completely contained within the system 
housing and constructed in such a way that no measurable radiation is detected 
during operation. No beam alignment nor X-ray beam calibration by the operator is 
required. There is no reason for any BTX III operator to bypass any radiation safety 
switches. The BTX III analyzer fully complies with the FDA CFR, section 1020.40 
including safety interlocks and radiation measurements. The BTX III analyzer has no 
measurable radiation leakage from any surface during operation. This is because of 
the shielding of the X-ray generation and detection components, and the low 
operating potential and power of the X-ray generation source.

The BTX III analyzer incorporates several independent safety interlock circuits to 
protect the operator. See Figure 2-1 on page 37 and Table 5 on page 38.
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Figure 2-1  BTX III radiation safety features

Depending on your location, the device may have a secondary indicator light on the 
top of the unit, and labels may be in French or English.

High Voltage/X-ray On LEDs

Interlock open LED
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2

3

NOTE
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Figure 2-2 on page 39 shows the LEDs described in Table 5 on page 38. Table 6 on 
page 40 describes the behavior of the LEDs in relation to X-ray emissions.

Depending on your location, the device may have a secondary indicator light (LED 3 
in Table 6 on page 40) on the top of the unit, and labels may be in French or English.

Table 5  BTX III radiation safety features 

Label Safety feature

1 Sample chamber interlock
The X-ray beam only operates when the sample carrier is properly 
inserted into the system. If the carrier is removed while the system is in 
operation, the high-voltage power supply interrupts and X-ray 
generation ceases.

2 High voltage/X-ray On LEDs
These LEDs glow red whenever high voltage is enabled and X-ray 
generation is possible.

3 Interlock open LED
This LED is normally off. It glows amber when a safety interlock 
switch has been opened. A safety interlock switch could be triggered 
by removing the sample carrier during a sample analysis.

4 Power key switch
The power key switch has ON and OFF positions. The key must be 
inserted and in the ON position for the system to operate, including 
operation of the X-ray beam.

5 Control panel interlock (not shown)
This is a magnetic switch that prevents the operation of high voltage 
when the control panel (top panel) is improperly seated or removed 
from the outer case. Under these conditions, the X-ray beam will not 
operate.

NOTE
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Figure 2-2  BTX III LED indicators
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2.3 Radiation Dose Measurements

Radiation dose measurements were made to document any possible ionizing 
radiation dose to a typical operator of the BTX III XRD analyzer. The measurements 
were made using a calibrated Ludlum Model 9-3 Radiation Ion Chamber. This 
chamber is capable of measuring low energy X-ray fields to within plus or minus 20 % 
of true value above 10 keV, with a typical counting range of 0 µC/kg to 51.6 µC/kg 
(0 mR/hr to 200 mR/hr).

During testing, the BTX III analyzer was operated at X-ray tube conditions that are 
standard for all testing materials (30 kV, 360 µA in France, 330 µA in the rest of the 
world). Radiation dose measurements were made at specific locations at the base, 
back, front, and sides of the system.

Radiation dose measurements around the perimeter of the system, at a distance of less 
than 2 cm, yielded no measurable radiation levels (less than 0.2 mR/h). This level is 
well within acceptable levels of exposure to the general public. When properly set up 
and operated, there is no exposure in excess of the typical dosage to the general public 
of naturally occurring sources of ionizing radiation.

Table 6  LED behavior 

Case High 
voltage X-ray LED 1 

(red)
LED2 

(amber)
LED 3 
(red)

1 On On On Off On

2 Off Off LED FAIL 
(Off)

Off Off

3 Off Off Off Off LED FAIL 
(Off)

4a

a. A current drop during a measurement can be related to a filament failure. In such a case, please 
contact the Olympus After-Sales Service. If the filament fails, the X-ray automatically turns off 
while the high voltage remains active. The X-ray tube is specifically designed to withstand such 
a breakdown and the electrical safety is maintained.

On FILAMENT FAILURE (Off) On Off On

5 Off INTERLOCKS OPEN (Off) Off On Off
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Figure 2-3 on page 41 shows the radiation dose measurement points. The radiation 
levels measured at these points are reported in Table 7 on page 42. All measurements 
were made at a maximum power setting of 30 kV and 360 µA in France (330 µA in the 
rest of the world).

Figure 2-3  Radiation measurement points

Depending on your location, the device may have a secondary indicator light on the 
top of the unit.
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Table 7  Radiation level measurements 

Measurement 
point

Measured radiation 
level in µC/kg (R/hr)

Distance from 
surface (cm) Comments

A < 0.0129 (0.00005) 2 Front top panel 
B < 0.0129 (0.00005) 2 Left side of case
C < 0.0129 (0.00005) 2 Front side of case
D < 0.0129 (0.00005) 2 Right side of case
E < 0.0129 (0.00005) 2 Back side of case
F < 0.0129 (0.00005) 2 Bottom of case
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3. Set Up and Operation

This chapter provides information for turning on and off the BTX III XRD analyzer 
and preparing and testing samples.

3.1 Connecting AC Power to the BTX III

The BTX III analyzer receives AC power through the External Power connector.

To connect AC power

If an unauthorized power supply cord is used to power the instrument, Olympus 
cannot guarantee the electrical safety of the equipment. 

1. Hold the power supply output plug in the orientation shown, and then insert it 
into the rear panel Power connector (see Figure 3-1 on page 44).

CAUTION
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Figure 3-1  Power plug and connector

2. Plug one end of the AC power cord firmly into the power supply (see Figure 3-2 
on page 44).

Figure 3-2  Power supply
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3. Plug the other end of the AC power cord into a live AC (mains) power outlet.

3.2 Turning On or Off the BTX III

To turn on the BTX III

 Turn the power key switch clockwise to the ON position (see  on page 28).
The system briefly displays the message:

Welcome to BTX---Booting
Please wait

After about a minute, the display reads:
Cooling to: –45
Current temp: (temperature)

After the detector cools to –45 °C, the menu appears (see Figure 3-3 on page 45).

Figure 3-3  Menu

Depending on your location, the menu may be in French or English.
NOTE
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To turn off the BTX III in an emergency situation

 Turn the power key switch to OFF.
OR

Press the Stop/Emergency Shutoff button ( ) twice (quickly).

To turn off the BTX III under normal conditions

1. On the menu, select Shut Down to power the unit off.
The display reads:

Shutting down...
Please wait...

2. After the unit is off, turn the power key switch to OFF.

3.3 Preparing a Sample for Analysis

BTX III analyzer is designed to operate with coarsely ground samples. The samples 
must be dry and be able to pass through a 150 µm sieve. Also the sample size should 
be large enough to convect within the sample cell. Very small particles generally do 
not perform well within a standard BTX III sample cell. The particles tend to stick to 
one another and not convect as they should. If you encounter this condition, contact 
Olympus for details on either increasing the sample cell volume, or to purchase an 
alternate sample cell.

To prepare a sample for analysis

1. Crush the sample in a crusher (see Figure 3-4 on page 47).
The result is a sample with a variety of particle sizes.
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Figure 3-4  Crushing a sample

2. Refine the sample further using a sample sieve (see Figure 3-5 on page 47).

Figure 3-5  Sample sieves

3.4 Loading a Sample

Before you can load a crushed sample into the BTX III analyzer, you must remove the 
sample carrier from the instrument, then load the sample into the sample cell.

There are four components of a sample cell (see Figure 3-6 on page 48):
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• An inner cell window comprised of a polymer window on a metal frame with a 
notch at the top

• A spacer, which is assembled between the inner and outer cell
• An outer cell window that also has a polymer window on a metal frame, but 

without a notch at the top
• Screws to secure the cell assembly to a sample cell carrier

Figure 3-6  Sample cell window components

The BTX III analyzer has a sample carrier that can accommodate two cell assemblies. 
Only side A should be used when loading a cell. Side B is provided as a counter mass 
for vibration and as a spare cell (see Figure 3-7 on page 48).

Figure 3-7  Sample carrier

Inner window

Spacer

Outer window Screws

Side B

Side A
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The BTX III analyzer is supplied with an external shaker assembly to ease sample 
loading and unloading (see Figure 3-8 on page 49). The external shaker assembly is 
used in conjunction with the sample cell carrier to “shake” or vibrate the sample into 
the cell assembly.

Figure 3-8  External shaker assembly

To remove the sample carrier

1. Lift the lever to unlock the sample carrier (see Figure 3-9 on page 49).

Figure 3-9  Unlocking the sample carrier

2. Pull up the carrier handle to remove the sample carrier (see Figure 3-10 on 
page 50).
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Figure 3-10  Removing the sample carrier

To assemble a cell

1. Lay the inner window down first (see Figure 3-11 on page 50).
Make sure that the polymer film faces up.

2. Place the spacer on top of the inner window.
3. Place the outer window on top of the spacer.

Make sure that the polymer film faces the spacer.

Figure 3-11  Sample cell window components

4. Align the windows and spacer so that the holes in the cell assembly are aligned 
with the holes in the sample carrier (see Figure 3-12 on page 51).

5. Replace the holding screws, being very careful not to puncture the polymer 
window material.

6. Tighten the holding screws.

Inner window

Spacer

Outer window
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Figure 3-12  Sample cell ready for screws

To load a sample into a sample cell

1. Connect the external shaker plug to the External Shaker connector on the rear 
panel (see Figure 3-13 on page 51).

Figure 3-13  External shaker plug connected

Cell windows aligned and stacked in proper sequence

External shaker plug
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2. Insert the sample carrier into the external shaker and gradually load a small 
amount of material (enough to fill the gap created by the spacer) into the side A 
cell assembly (see Figure 3-14 on page 52).
The material should be approximately 50 mg of coarsely ground (100–150 µm) 
powder.

Figure 3-14  Loading the sample

3. On the main menu, select Shake, then press the Check button ( ).
The external shaker vibrates to aid in loading the sample.

4. Adjust the shaking amplitude using the Left arrow ( ) and Right arrow 

( ) buttons.

5. To save the selected shaking amplitude value, press the Check button ( ).

6. When the cell appears to be full, press the Stop button ( ), and then remove 
the sample carrier from the external shaker.

External
shaker
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3.5 Testing a Sample

To test a sample

1. Insert the sample carrier into the sample chamber, making sure that side A is 
oriented toward the right side of the system (see Figure 3-15 on page 53).

Figure 3-15  Inserting the sample carrier

2. Lock the sample carrier in place by pushing the lever down (see Figure 3-16 on 
page 54).

Side A
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Figure 3-16  Locking the sample carrier down

3. Select Start acquisition in the display, then select a running mode (see Table 8 on 
page 54).

Table 8  Running modes 

Menu level 
one

Menu level 
two Level two choice Comments

Start 
acquisition

Choose Mode

*Default* Uses the default test mode 
that has been set up by the 
administrator in the 
SwiftMin® software (see 
“Mode Setup Tab” on 
page 76).

 Custom modes Uses a test mode that has 
been set up by the 
administrator in the 
SwiftMin® software (see 
“Mode Setup Tab” on 
page 76).

Shake
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4. Press the Check button ( ) to start the test.
When the test begins, the BTX III analyzer gives the data set a name based on a 
sequential number. The red LEDs glow, indicating the application of high voltage 
to the X-ray tube. The display shows the voltage and intensity readings, and the 
sample carrier emits a high-pitched vibration noise.

In some locations you can only start tests using the Check 
button on the front panel keypad. Tests cannot be started through the BTX III 
SwiftMin® software user interface.

Shaking
X to quit

Initiates vibration of the 
external shaker assembly, 
assuming it is connected. 
Press the Stop button on 
the keypad to terminate 
external shaking. Adjust 
the shaking amplitude 
with the left and right 
arrows. Save this value 
with the Check key.

Do USB 
Transfer

Choose 
Dataset

(Data set) Selects the data set that is 
transferred to the USB flash 
drive.

Shut Down Turns off the BTX III 
analyzer. The system takes 
a few minutes to slowly 
warm up the detector, 
preventing condensation 
from forming and avoiding 
damage.

Table 8  Running modes (continued)

Menu level 
one

Menu level 
two Level two choice Comments
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To stop testing before all the exposures are taken

 Press the Stop button ( ) once.

3.6 Unloading a Sample

To remove the sample carrier from the sample chamber

1. Lift the lever to unlock the sample carrier.
2. Lift the sample carrier out of the sample chamber.

To unload a sample from the sample cell

 Remove the majority of the material with the aid of the external shaker assembly.

OR

1. Using a 1.5 mm hex driver, carefully remove the holding screws, and then 
disassemble the cell windows and spacer (see Figure 3-17 on page 56).

2. Clean or replace the cell parts as necessary.

Figure 3-17  Cell disassembly
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4. Local Area Network Communication

You must establish a local area network (LAN) connection between your PC, tablet, or 
other device and the BTX III analyzer before you can use a web browser to run the 
SwiftMin® software (see “SwiftMin® Software User Interface” on page 65).

You can set up the BTX III to communicate with a LAN using one of the two 
following methods:

• Connect an Ethernet cable to the Ethernet connector to establish a wired LAN.
• Connect a wireless LAN dongle to the USB connector to establish a wireless LAN.

Your PC, tablet, or other device must be wireless LAN (WLAN) enabled with a 
compliant 802.11b/g/n connection. 

The device you use to communicate with the BTX III must be capable of supporting 
the full functionality of the SwiftMin® software.

Your LAN must be capable of connecting using Dynamic Host Configuration Protocol 
(DHCP). If your network does not recognize DHCP, contact your IT department for 
the proper addresses.
Local Area Network Communication 57



10-015490-01EN, Rev. 3, June 2021
4.1 Checking the Network Configuration

The BTX III can connect to either a wired LAN or broadcast a wireless LAN, but not 
both at the same time. The wired LAN connection is the default if an Ethernet cable 
and a wireless LAN dongle are both connected to the BTX III at the same time.

To check the network configuration 

The default network setting of the BTX III is WIRED ON (Ethernet).

1. Make sure the BTX III is on and the Main menu is displayed.

2. Briefly press both the Left arrow ( ) and Right arrow ( ) buttons at the 
same time to display the Advanced menu (see Figure 4-1 on page 58).

3. Press the Down arrow button ( ) to select Configure Network.

Figure 4-1  Advanced menu

4. Press the Check button ( ) to confirm the selection and display the DHCP 

(Dynamic Host Configuration Protocol) menu (see Figure 4-2 on page 59).
— If the LAN is already set to WIRED ON, the BTX III is configured to connect 

to your LAN through the Ethernet connector. 

NOTE
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See “Broadcasting a WLAN through a Wireless LAN Dongle” on page 60 for 
instructions on setting WIRED to OFF.

— If the LAN is set to WIRED OFF, the BTX III is configured to broadcast a 
WLAN through a wireless LAN dongle.
See “Connecting to your LAN through the Ethernet Connector” on page 59 
for instructions on setting WIRED to ON.

Figure 4-2  DHCP menu

4.2 Connecting to your LAN through the Ethernet Connector

When the LAN is set to WIRED ON, the BTX III is configured to connect to your LAN 
through the Ethernet connector.

To connect to your LAN through the Ethernet connector

1. Connect an Ethernet cable to the Ethernet connector on the rear of the BTX III.
2. Use the arrow buttons to set WIRED to ON:

a) Use the right arrow button ( ) to move from the WIRED field to the OFF 
field.

b) Use the up or down arrow button ( ) to change the value to ON.
3. To quickly set up the protocol, use the arrow buttons to set DHCP to ON (see 

Figure 4-3 on page 60). Otherwise, change the DHCP parameters using the arrow 
buttons.
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Figure 4-3  DHCP menu

4. Press the Check button ( ) to accept the changes and restart the BTX III.
The BTX III restarts with the new DHCP configuration.

5. After the BTX III has restarted, navigate back through Main Menu > Advanced 
Menu > Configure Network > DHCP Menu to view the network-assigned IP 
address (see Figure 4-4 on page 60).

The network-assigned IP address must be used in your Web browser to access the 
BTX III software.

Figure 4-4  Network-assigned IP address

4.3 Broadcasting a WLAN through a Wireless LAN Dongle

When the LAN is set to WIRED OFF, the BTX III is configured to broadcast a WLAN 
through a wireless LAN dongle.

To broadcast a WLAN through the wireless LAN dongle

1. Connect a wireless LAN dongle to the rear panel USB port.
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2. Use the arrow buttons to set WIRED to OFF:

— Use the right arrow button ( ) to move from the WIRED field to the ON 
field.

— Use the up or down arrow button ( ) to change the value to OFF (see 
Figure 4-5 on page 61).

Figure 4-5  DHCP menu

3. Press the Check button ( ) to accept the changes and restart the BTX III.
The BTX III restarts with the new DHCP configuration and begins broadcasting a 
WLAN.

4.4 Connecting your PC to the WLAN

Through the wireless LAN dongle, the BTX III broadcasts an unsecured WLAN that is 
identified by the serial number of the analyzer. For example, if the serial number of 
your BTX III is “670,” then it broadcasts on a network identified as “BTX-670.”

To connect your PC to the WLAN

1. Turn on your WLAN-configured BTX III and wait until the menu is displayed (see 
Figure 4-6 on page 62).
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Figure 4-6  Menu

Depending on your location, the menu may be in French or English.

In your PC available networks menu, find the serial number associated with your 
BTX III (see Figure 4-7 on page 62).

Figure 4-7  BTX III network broadcasting

NOTE
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2. Connect your PC to the BTX III (see Figure 4-8 on page 63).
You are now ready to set up and run tests using the SwiftMin® software (see 
“SwiftMin® Software User Interface” on page 65).

Figure 4-8  BTX III network selected (left) and connected (right)
Local Area Network Communication 63



10-015490-01EN, Rev. 3, June 2021
Chapter 464



10-015490-01EN, Rev. 3, June 2021
5. SwiftMin® Software User Interface

The SwiftMin® software user interface (UI) enables you to set up and run tests on the 
BTX III X-ray diffraction analyzer.

The web browser that you use to run the SwiftMin® software must be capable of 
supporting the full SwiftMin® functionality.

5.1 Opening and Closing the SwiftMin® Software User Interface

The SwiftMin® software UI runs in a web browser of your choice.

To open the SwiftMin® software user interface

1. Start a web browser on your device.
2. Type the network-assigned IP address displayed on the DHCP menu into the 

browser address bar if using Ethernet, or type http://192.168.0.222 into the 
browser address bar if using the WLAN.
This initiates a connection with the SwiftMin® software and displays the UI (see 
Figure 5-1 on page 66).

NOTE
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Figure 5-1  SwiftMin® software user interface

To close the SwiftMin® software user interface

 In your web browser, close the XRDApp tab.

5.2 SwiftMin® User Access Levels

The SwiftMin® software provides two user access levels:

• Default
• Manager

The Default access level is used for real-time operation of the BTX III analyzer. The 
Manager access level also provides real-time operational capability, and can also be 
used to configure the mineral databases and test parameters of the instrument.

To acquire the password for the Manager login, contact your Olympus sales 
representative.

NOTE
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5.2.1 Default Access

Default access is available when the software starts up. No password is required. 
Three screens are available:

• Live Operator
• Results
• About

Screen names that you cannot access are grayed out.

The Live Operator screen is displayed when the software starts up. The Results and 
About screens are selectable.

5.2.2 Manager Access

Manager access is password protected. Five screens are available:

• Live Operator
• Mode Setup
• Mineral Config
• Results
• About

The Factory Settings screen is grayed out.

To log in with Manager access

1. Click the icon in the upper-right corner of the screen (see Figure 5-2 on page 68).

NOTE

NOTE
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Figure 5-2  Manager access icon

2. In the dialog box, click Login.
3. Enter the password in the Enter Password dialog box, and click Ok (see 

Figure 5-3 on page 68).

Figure 5-3  Enter Password dialog box

To log out of Manager access

1. Click the icon in the upper-right corner of the screen.
2. In the dialog box, click Logout.

5.3 Using the SwiftMin® Software

The software workflow depends on your access level.
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To change the current screen

 In the menu bar, click the tab of the screen you want to display (see Figure 5-4 on 
page 69).

Figure 5-4  Menu bar

5.3.1 Screen Tabs

The screen tabs enable you to access the workflows.

• Live Operator
Used to start or stop a test and to check the status of the instrument.

• Mode Setup (not available with default access)
Used to add, edit, and delete modes. A mode includes test parameters such as the 
SwiftMin® and SwiftMin® RIR databases, number of exposures, piezo volume, 
and network parameters.

• Mineral Config (not available with default access)
Used to quickly edit SwiftMin® RIR databases, and upload or download 
SwiftMin® RIR databases as .csv files for more extensive editing.

• Results
Used to view, review, or download current or past results and data. Can also set 
the calibration.

• About
Displays version and licensing information about the SwiftMin® software.

5.3.2 Default Access Workflow

This workflow enables you to set up and run a test, then download selected results. 
You can view and download the current result or previous results.
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To run a test

1. In Test dialog box of the Live Operator screen, select a test mode (see Figure 5-5 
on page 70).

2. In the Sample Info dialog box, enter a Sample Name (30 alphanumeric characters 
maximum).
Optionally enter information into Info Field1 (10 characters maximum) and/or 
Info Field2 (4 characters maximum).
The information that you enter in the Sample Info dialog box can be used to 
uniquely identify the test in the Results screen.
For example, if you enter “BakerShaleA420” in Sample Name, “20” in Info 
Field1, and “3X” in Info Field2, the test name will appear in the results data as 
“BakerShaleA420_20_3X”

3. In Test area, click Start.

Figure 5-5  Test and Sample Info areas

In some locations you can only start tests using the Check button on the front panel 
keypad. Tests cannot be started through the BTX III SwiftMin® software user 
interface.

The test will run until complete. Results are displayed as the test progresses. 

To stop a test

 Click Stop (see Figure 5-5 on page 70).
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To search for a result

1. Click the Results tab.
2. In the Date/Mode dialog box (see Figure 5-6 on page 71), use the calendar to find 

results by date (optional).
Use the Start date and/or End date choices to select a date range.

Figure 5-6  Date/Mode dialog box

3. Select a mode.
If you do not select a mode, the last selected mode is used.

4. Click Apply.
5. In the list that appears, choose the date and result that you want to display (see 

Figure 5-7 on page 72).
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Figure 5-7  Result selected in list

To download the result data

 Click Download Data to download the results data to your PC.

To download the results

 Click Download Results to save the results only for the highlighted sample to the 
BTX III analyzer.

5.3.3 Manager Access Workflow

Manager access includes all of the Default access level functionality, and you can also 
configure mineral databases and test parameters of the instrument.

The BTX III manager can select a SwiftMin® reference intensity ratio (RIR) mineral 
database to edit within the SwiftMin® UI, and then save that database for later 
selection. The BTX III manager can also upload and download the SwiftMin® 
Chapter 572



10-015490-01EN, Rev. 3, June 2021
American Mineralogist Crystal Structure Database (AMCSD) (.txt) and SwiftMin® 
RIR mineral databases (csv). This feature is useful to make extensive edits to existing 
RIR databases.

The BTX III manager can also add, edit, or delete test modes.

5.3.3.1 Mineral Config Tab

This tab enables you to configure mineral databases.

To work with the .csv mineral database

1. Click the Mineral Config tab.
2. Click the down arrow in the SwiftMin DB selection box, and choose a database 

(see Figure 5-8 on page 74).
After you select a database, the mineral list for that database is displayed.

3. In the mineral list, click the check box of the mineral that you want to enable or 
disable in the database (see Figure 5-8 on page 74).

4. Click SaveAs to save the database with a new or edited name.
The database is saved to the hard drive on the BTX III analyzer.

To avoid confusion, it is good practice to save the database with a new or edited name 
(by clicking SaveAs), indicating that a change was made.

NOTE
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Figure 5-8  Choosing a database (left) and editing the mineral list (right)

To upload a .csv or .txt mineral database

1. Click Upload Database to open a file explorer window (see Figure 5-9 on 
page 75).

2. In the file explorer, navigate to your database file directory.
3. Select a database file, and click Open.
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Figure 5-9  Upload database

To download a .csv or .txt mineral database

1. Click Download Database.
2. In the dialog box, click the down arrow beside the database you want to 

download (see Figure 5-10 on page 76).
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Figure 5-10  Download Database dialog box

To set the calibration

 Click Set Calibration.
The spectrum is selected to calibrate the SwiftMin® software for database 
searching, which ensures the identified materials are correct.

5.3.3.2 Mode Setup Tab

The Mode setup tab is where you set up the test modes for selection in the Live 
Operator screen. You can change default test mode parameters, or add, edit, or delete 
modes. You can also change the current default database to either the AMCSD or 
another RIR mineral database.

The parameters for the default mode are displayed on the left side of the screen. The 
available custom modes are displayed on the right.
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To change the default database

1. Click on a default database and select a different database (see Figure 5-11 on 
page 77).

2. Click Save.

Figure 5-11  Changing the default database

To change any of the other default values

1. Highlight the value to select.
2. Type the new value.
3. Click Save.
SwiftMin® Software User Interface 77



10-015490-01EN, Rev. 3, June 2021
To add a new mode

1. At the bottom of the Custom Modes dialog box, click Add New Mode (see 
Figure 5-12 on page 78) to display the Add New Mode dialog box.

Figure 5-12  Add New Mode button

2. In the dialog box, select the Add New Mode field and type the name of the new 
mode (see Figure 5-13 on page 79).

3. Select the default database (see “To change the default database” on page 77).
4. Change any of the other default settings (see “To change any of the other default 

values” on page 77).
5. Click Add.
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Figure 5-13  Add New Mode dialog box

To edit an existing mode

1. Click an Edit button (see Figure 5-14 on page 80).
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Figure 5-14  Edit buttons

2. In the Editing dialog box, (see Figure 5-15 on page 80) select the default database 
(see “To change the default database” on page 77).

3. Change any of the other default settings (see “To change any of the other default 
values” on page 77).

4. Optionally, select the mode name and then type to change the name of the mode.
5. Click Save.

Figure 5-15  Editing dialog box
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To delete a mode

 Click a Delete button (see Figure 5-16 on page 81).

Figure 5-16  Delete buttons

5.3.4 Changing the User Interface Language

The Language tab enables you to change the language in the UI.

To change the user interface language

1. Click the language displayed in the Language tab.
2. Select a language from the list.
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Appendix A: Specifications

The BTX III X-ray diffraction analyzer operating characteristics differ depending on 
the operating temperature. The BTX III analyzer consumes more power at higher 
ambient temperatures as it cools the CCD X-ray detector. See Table 9 on page 83 for 
full specifications.

Table 9  BTX III specifications 

Parameter Specification
XRD resolution 0.25° 2θ FWHM
XRD range 5–55° 2θ
Detector type 1024 × 256 pixels 2-D Peltier-cooled CCD
Sample grain size <150 µm crushed powder (100 mesh screen, 150 µm)
Sample quantity ~15 mg
X-ray target material Cu (Co optional)
X-ray tube voltage 30 kV
X-ray tube current France: 360 µA

Rest of the World: 330 µA
Data storage 240 GB ruggedized internal hard drive
Wireless connectivity 802.11b/g (enables remote control from web browser)
Operating temperature −10 °C to 35 °C (14 °F to 95 °F)
Weight 12.5 kg
Dimensions 30 cm × 17 cm × 47 cm (11.8 in. × 6.9 in. × 18.5 in.)
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Appendix B: About Powder XRD Testing

The most commonly used crystallographic approach of XRD is powder X-ray 
diffraction (PXRD). The sample in PXRD is a powdered (polycrystalline) material, 
which is composed of many small crystallites that randomly assume all possible 
orientations with respect to the incident beam. In a PXRD experiment, a relatively 
small proportion of the grains contribute to a given diffracted beam. Higher numbers 
of randomly oriented grains exposed to the X-ray lead to better statistical 
representation for any given diffraction direction. This is referred to as particle 
statistics.

Powder X-ray diffraction instruments require limited analytical volume to provide 
good resolution, so particle statistics are achieved using very fine grains of typically 
smaller than a few tens of micrometers. Particle statistics become even more critical 
with miniature systems because of the reduced size of their analytical volume. 
Conditions for good particle statistics vary, depending on parameters such as the 
symmetries in the crystal lattice, the abundance of the phase in the sample, and the 
geometry of the system. A general rule of thumb for powder XRD is that at least 106 
grains are needed to provide appropriate particle statistics. This is achieved in the 
BTX III with sub-micron powders that lead to continuous Debye rings when using 
static samples. Very spotty rings are observed for grain sizes above 10 µm (the term 
spottiness is often used to refer to insufficient particle statistics).

When the grain size of the sample is not small enough to guarantee appropriate 
particle statistics, means to increase the number of crystal orientations effectively 
analyzed must be applied. This is typically done by translating or rotating the sample 
in the beam to analyze a larger amount of material or explore more orientations of the 
same grains. A novel method employed in the BTX III XRD analyzer consists of 
placing the granular sample in motion using granular convection in vibrated cells. 
This method is very effective at improving particle statistics and enables analysis of 
materials with a grain size of up to 150 µm. This sample handling method relaxes the 
constraints on sample preparation by allowing grains nearly two orders of magnitude 
larger than ideal to be analyzed, while facilitating loading and removal of the powder.
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See Figure B-1 on page 86. In example A (a still sample), partial diffraction rings and 
Laue spots are observed. In example B, with granular convection, complete diffraction 
rings are observed (what is known as a perfect powder pattern).

Figure B-1  BTX III XRD diffraction patterns: NaCl crushed and sieved to <150 µm

A B
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Appendix C: Data Analysis

The XPowder application software can be used to accomplish in-depth data analysis 
of a wide range of powdered substances. This software is supplied with your BTX III 
X-ray diffraction analyzer on the USB flash drive. This appendix includes instructions 
on installing the software and using it to verify alignment of the system using a quartz 
sample (not supplied).

To install XPowder

1. Connect the USB flash drive (supplied) to a USB port of a computer.

2. Find the xpowder_setup.exe ( ) file, and then double-click the icon to run the 
program.

3. Follow the instructions in the setup wizard (see Figure C-1 on page 88) as the 
installation progresses.
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Figure C-1  XPowder setup wizard

4. When the installation is complete, copy the registration code from the “License 
key” document on the USB flash drive.

5. Click Main menu > Help > XPowder registration code and paste the license key 
in the text box.

To load the DIFDATA database

1. Click Database > Database Install.
2. In the Drive list, click the down arrow to locate the USB flash drive (see 

Figure C-2 on page 89).
3. Under Click database file, select the Difdata.txt file.
4. In the Database file extension list, click the down arrow, and then select *.txt.
5. Under Default scanning interval (Angstroms), in the Higher d-spacing box, type 

70.00, and then, in the Lower d-spacing box, type 1.64.
6. In the Database nickname box, type AMCSD.
7. Select Add a new Database.
8. Click Install.
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Figure C-2  Database install

To load test data

1. Click File > Open.
2. In the file type list change the file type to x,y (ascii.txt, asc, xy,x_y) [see Figure C-3 

on page 90].
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Figure C-3  Open File dialog box

3. Locate the file containing your quartz sample results. Ensure the file name ends 
with 
-film.txt

4. Click Open to display the XPowder home screen and the superimposed 
Wavelength setup dialog box (see Figure C-4 on page 91).
Appendix C90



10-015490-01EN, Rev. 3, June 2021
Figure C-4  Results screen and Wavelength setup dialog box

The Wavelength setup dialog box is used to set the X-ray tube type, and 
automatically displays only on initial software setup.

5. In the X-ray tube anode list, select either Co or Cu.
6. The selection depends on the type of X-ray tube in your system.
7. Click OK.

To analyze the test data

1. In the XPowder menu, click Action > Background subtraction to display the 
Background subtraction dialog box (see Figure C-5 on page 92).

NOTE
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Figure C-5  Background subtraction menu

2. Without changing any of the parameters, click Do it!
3. Click Yes in the confirmation dialog box.

4. On the XPowder tool bar, click Advanced searching ( ).
The advanced searching window containing a diffractogram appears.

5. In the diffractogram, click within the (blue) background subtraction area to 
decrease the amount of background subtraction (see Figure C-6 on page 92).
The purpose of decreasing or increasing the amount of background subtraction is 
to eliminate as much noise as possible while preserving as many peaks as 
possible.

Figure C-6  Advanced searching windows

Background subtraction set too high — Some peaks 
are eliminated.

Background subtraction decreased — Most peaks 
are preserved.
Appendix C92



10-015490-01EN, Rev. 3, June 2021
6. In the Searching parameters area, set the 2-theta gap to 0.30 (see Figure C-7 on 
page 93).

Figure C-7  Advanced searching — Searching parameters area

7. In the Matching criteria box, select 2 reflections option (both the radio button 
and check box).

8. Click Search.
The search results are displayed in the XPowder window with a dialog box 
superimposed (see Figure C-8 on page 94). The dialog box name is based on the 
name of the CCD image file exported from the BTX II. In Figure C-8 on page 94, 
the dialog box name is RemoteTst-film in AMCSD.
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Figure C-8  XPowder results window

9. In the Least squares fitting area of the dialog box, click the Automatic check box.
The XPowder software identifies the first crystal/phase that best matches the 
pattern.

10. In the phase list, click the check box of the highlighted phase to identify the next 
phase most likely to fit the pattern.
In many cases, this is another isomer of the same crystal/phase.

11. Click Unchecks to eliminate unchecked (unwanted) phases (see Figure C-9 on 
page 95).

XPowder window

Dialog box
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Figure C-9  Dialog box showing the selected phase

12. Click Display card to inspect the phase details (see Figure C-10 on page 95).

Figure C-10  Phase detail display card

13. In the XPowder window, click Quantitative > LS-RIR Database Cards to view a 
relative intensity ratio semiquantitative analysis and summary (see Figure C-11 
on page 96).
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Figure C-11  Quantitative screen

14. To view a log report, click File > Save log file as TXT to generate a text file record 
of the session.
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